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1  Introduction 

1.1  About this document 

This is the operation manual for WinActor Note.  
This manual is intended for those who create scenarios for WinActor using WinActor 
Note. 

 

1.2  Trademarks 

The names described below and other names of companies and products in this 
document are trademarks or registered trademarks of their respective companies. The 
TM, ®, and © marks are omitted in this document. 
 

・ Windows and Windows PowerShell are trademarks or registered trademarks 
of Microsoft Corporation in the United States and other countries. 
* The official name of Windows is Microsoft Windows Operating System. 

 

・ The name of CentOS is a trademark or registered trademark of CentOS ltd.  
 

・ Ubuntu is a trademark or registered trademark of Canonical Ltd. 
 

1.3  Notes on this manual 

・ The copyright notice "Copyright © 2013-2025 NTT, Inc. & NTT ADVANCED 
TECHNOLOGY CORPORATION" attached to this manual and the provided 
software cannot be changed or deleted. 
The copyright of this manual belongs to NTT, Inc. and NTT ADVANCED 
TECHNOLOGY CORPORATION.  
 

・ The descriptions in this manual assume that users understand Windows 
operations and functions. For information that is not described in this manual, 
see the documents provided by Microsoft.  

 

1.4  Launching WinActor Note 

To open the WinActor Note window, click "WinActor Note" from "Tool" of WinActor. 
 

 

Figure 1. Launching WinActor Note 
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2  WinActor Note 

 

2.1  About WinActor Note 

WinActor Note is a tool for processing, extracting and using complex texts by 
creating and running a WinActor Note macro that combines text processing operations. 

The relationship between WinActor Note and WinActor is as follows. 
 

 

Figure 2. Relationship diagram between WinActor Note and WinActor 

 
By specifying and running a WinActor Note macro from the WinActor library, 

WinActor Note runs operations recorded in the macro. WinActor gets text information 
from WinActor Note and uses the extracted text information in a scenario by using 
existing nodes and libraries.  

For scenario creations using WinActor Note, see "WinActor Note Text Processing 
Scenario Creation Manual" and "WinActor Note Terminal Function Scenario Creation 
Manual." 

 

2.2  Operation flow of WinActor Note 

The processing flow is as follows. (For details, see each chapter.) 
 

WinActor scenario WinActor Note macro 

WinActor Note WinActor 

Note_ReadAndRunMacro 

Get the text information 

Use the text information 

Load texts 

Process and extract the texts 

Output the texts 

Text 

information 

Macro 

file 
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Figure 3. Operation flow image 

 

① Load a file, clipboard, or string to process text information. (See 4. Input) 

Or, use Terminal functions such as "SSH tool" and "Telnet tool" (see 11. 

Terminal) or Filer functions such as "Select a folder" (see 12. Filer) to display 

strings. 

 

② Perform processing to process and extract the displayed strings. (See 6. Block 
extraction, 7. Sort, 8. Cursor movement, 9. Mark, and 10. Edit) 
 

③ Output the processed and extracted strings. (See 5. Output) 

 

  

Text information 

WinActor Note macro 

defg 
defg 

ab c 

abc 

hijk 

defg 

ab c 

defg 

Output the text information (Step ③) 

Process and extract the text information (Step ②) 

Load text information (Step ①) 

Extract Sort Edit 
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3  Window elements 

3.1  Window elements 

The window elements of WinActor Note is as shown below.  

On the menu bar, there are menus for running each function.  

You can operate multiple text areas by switching tabs 

The status bar shows the status of the text area.  

The blue part in the text area is the position of the cursor.  

If you change the operation mode to the "View" mode, the menu bar will be 

deactivated.  

 

* For details of the operation mode, see "WinActor Note Text Processing Scenario 

Creation Manual." 

 

 
 

Figure 4. WinActor Note window elements  

Menu 

Tab 

Status 

Text area 



 

5 

WinActor Note  Operation Manual Cursor and block 

 

3.2  Cursor and block 

The blue bar in the text area indicates the position of the cursor. "Cursor position" 
is displayed on the status bar.  

 

 

Figure 5. WinActor Note with three-line texts loaded 

 
When a text file with three lines is loaded into WinActor Note, "TOP" is displayed at 

the top of the text area, followed by three lines of the text file and "EOT" at the bottom. 
* EOT stands for End Of Text. 
 
WinActor Note manages texts in a unit called "block."  
One line of the text file is read as one block, so if three lines of texts are loaded, 

"Number of blocks: 3" will be displayed on the status bar.  
If you use "Block merge tool" described later, multiple lines can be treated as one 

block, so the number of lines does not always match the number of blocks.  
 
The cursor indicates the selected state of the block.  
 
Immediately after loading a text file, "Cursor position" on the status bar is "0" and 

the cursor is positioned at TOP. 

  

Cursor 
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3.3  Text area color 

TOP and EOT are gray. 
The block selected by the cursor turns blue.  
Other blocks of texts are light yellow and light green as shown below. 
 

 

Figure 6. Block color differences 

 

WinActor Note has a function to mark each block. Marked blocks have a light red 
background with red text. If the cursor is on a marked block, the block has a blue 
background with red text. 

 

Figure 7. Colors of the marked blocks 
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3.4  TOP and EOT 

TOP (the top of the text) and EOT (the end of the text) are special blocks that are 
required for coordination with a WinActor scenario. 

A WinActor scenario that reads texts of WinActor Note one by one generally has the 
structure shown below.  

The WinActor scenario continues reading the texts by repeatedly performing 
"Note_MoveCursorAndReadText" and "Note_ReadStatus." In 
"Note_MoveCursorAndReadText," the text is read after the cursor is moved down. In 
"Note_ReadStatus," the selected position is read. The repetition is set to be ended 
when the text is read at the position of EOT. 

* "Note_ReadBlockLoop" is included in the user library of WinActor.  

 

Figure 8. Example of the scenario for reading blocks one by one 
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3.4.1  Details of the scenario for reading blocks one by one 

The scenario of "Note_ReadBlockLoop" starts with the cursor at the TOP. 
 

  

Figure 9. Details of the scenario for reading blocks one by one (1) 

 
When the first "Note_MoveCursorAndReadText" is run, the cursor moves down one 

position and reads "Hello." 

 

  

Figure 10. Details of the scenario for reading blocks one by one (2) 

 
When the second "Note_MoveCursorAndReadText" is run, the cursor moves down 

one position and reads "Thank you." 
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Figure 11. Details of the scenario for reading blocks one by one (3) 

 

When the third "Note_MoveCursorAndReadText" is run, the cursor moves down 
one position and reads "Good bye." 

 

  

Figure 12. Details of the scenario for reading blocks one by one (4) 

 
When the fourth "Note_MoveCursorAndReadText" is run, the cursor moves down 

to EOT. As a result of reading the text at the EOT, "Exit from loop" runs and the 
scenario of "Note_ReadBlockLoop" ends. 

 

  

Figure 13. Details of the scenario for reading blocks one by one (5) 
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3.5  Status bar 

The status bar shows the status of the text area. 
 

 

Figure 14. Status bar 
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Table 1. Contents shown in the status bar 

Item Content Description 

Number of blocks Numerical 

value 

Shows the total number of blocks loaded in the text 

area. TOP and EOT are not counted in the number.  

Cursor position Numerical 

value 

Shows the number of the block selected by the 

cursor. It is 0 when TOP is selected. 

When EOT is selected, it will be the block number 

+1.  

Selection Applied or 

N/A 

Shows whether a block is selected or not.  

"N/A" when the cursor is at TOP or EOT, otherwise 

"Applied." 

Status EMPTY 

TOP 

EOT 

MARK 

Shows several status separated by "/." 

EMPTY…the selected block is empty  

TOP…TOP is selected  

EOT…EOT is selected 

MARK…the selected block is marked 

Terminal N/A 

Shell tool 

SSH tool 

Telnet tool 

Shows which terminal function session is open for 

the displayed text area.  

 

N/A: No session open  

Shell tool: PowerShell or Command Prompt 

session is open 

SSH tool: SSH command session is open 

Telnet tool: Telnet command session is open 

WorkFolder Work folder 

path 

Shows a current work folder. 
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3.6  Text area 

The text area displays texts being edited. 

In the text area, you can perform the operations shown in the tables below.  

 

Table 2. Key operations related to cursor movements 

Key Description 

↑ The cursor moves to the block above.  

↓ The cursor moves to the block below. 

Home The cursor moves to TOP. 

End The cursor moves to EOT. 

PageUp Scrolls upward about one page. 

Note: The moving width of the cursor differs depending on the size of the 

window and the contents of the text.  

PageDown Scrolls down about one page. 

Note: The moving width of the cursor differs depending on the size of the 

window and the contents of the text.  

P The cursor moves to a marked block upward from the current position. If 

there is no marked block upward, the cursor moves to TOP.  

N The cursor moves to a marked block downward from the current position. If 

there is no marked block downward, the cursor moves to EOT.  

 

Table 3. Operations related to text editing 

Key Description 

Delete Deletes the first character in a selected block.  

BackSpace Deletes the last character in a selected block.  

Shift+Delete Deletes a selected block.  

M Marks or unmarks a selected block. 

Ctrl+Z Undoes the last edit operation.  

Ctrl+Y Redoes the last undone edit operation.  
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3.7  Docking window 

The docking window is a function that allows you to float the Menu pane, the Edit 
macro pane, and the property pane for each menu item, and place them anywhere on 
the screen. 

 
 

3.7.1  Dragging a title bar 

You can change a position of the Menu pane, the Edit macro pane, or the property 
pane for each menu item by dragging their title bar with the mouse to float the window 
and dropping it to your desired position. 

 

 

Figure 15. Docking window 
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The procedure is as follows: 

① For example, you can change the position of the "Input tool" property pane by 
dragging and dropping its title bar. 

 
 
 

 

Figure 16. Changing the position of the "Input tool" pane 

 

3.7.2  Dragging a tab 

You can change a position of a pane by dragging its tab with the mouse to float the 
window and dropping it to your desired position. 

  

The procedure is as follows: 

② For example, you can change the position of the "Input tool" property pane by 
dragging and dropping its tab. 

 

Figure 17. Changing the position of the "Input tool" pane 
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3.7.3  Docking (entire window area) 

You can place (dock) a floating window inside WinActor Note by dragging and 
dropping it onto WinActor Note. 

 
The procedure is as follows: 

① Drag a floating window onto WinActor Note. The control appears on the four 
sides of WinActor Note. 

 

Figure 18. Docking the floating "Input tool" window 
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② Overlay the floating window on the control. The docking position will be 
displayed in a blue frame. 

 

Figure 19. Position to dock the "Input tool" window 

③ Drop the window to dock it at the position of the blue frame. 

 

Figure 20. Docked "Input tool" window 
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3.7.4  Docking (window pane) 

You can dock a floating window or place it as a tab by dragging and dropping it to 
the Menu pane, the Edit macro pane, or the property pane for each menu item. 

 
The procedure is as follows: 

① Drag a floating window to the Menu pane, the Edit macro pane, or the property 
pane for each menu item. The control appears on the center of the pane. 

 

Figure 21. Docking the floating "Input tool" window 
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② Drop the floating window to the right, left, top, or bottom of the control. 

 

 

Figure 22. Selecting the position to dock the "Input tool" window 

 

③ The window will be docked in the corresponding position (right, left, top, or 
bottom) of the pane. 
 

 

Figure 23. Docked "Input tool" window 
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④ Drop the floating window to the center of the control. 

 

Figure 24. Dropping the "Input tool" window to the center of the control 

 

⑤ The window will be docked as a tab. 
 

 

Figure 25. Tabbed "Input tool" window 
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3.7.5  Float/Dock menu 

You can float or dock a window from ▼ in the upper right of the Menu pane, the Edit 
macro pane, or the property pane for each menu item.  

 
The procedure is as follows: 

① Click ▼ in the upper right of the Menu pane, the Edit macro pane, or the 
property pane for each menu item to display the menu. Select "Float" in the 
displayed menu to float the selected tab.  

 
 

 

Figure 26. Selecting the "Float" menu  

② Select "Dock" in ▼ in the upper right of the floating window to dock it in its 
original position. 

  

③ Select "Close" in ▼ or click ‘×’ in the upper right of the window to close the 
selected tab.  
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3.7.6 Saving and restoring the layout 

The window/pane layout is automatically saved and restored when you quit and 
launch WinActor. The position and size of the floating window and the main window 
are saved in the registry, and they are restored from the registry at startup. 

・ When quitting WinActor: The current layout will be saved. 

・ When launching WinActor: The saved layout will be restored. If the layout has 
never been saved, the default layout will be restored. 

 
You can also save and restore the layout from the "View" menu of the menu bar. 
 

 

Figure 27. View menu 

 

Table 4. View menu 

No. Menu Description 

1 Save current layout Saves the current layout 

2 Restore layout Restores the saved layout. 

3 Restore initial layout Restores the default layout. 
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3.8  Language setting 

The setting is switched according to the language of WinActor at startup. 
 

 

4  Input 

4.1  Input menu 

The Input menu has functions for inputting text data into the text area of WinActor 
Note. Use this menu when inputting data from a file or the clipboard.  

 

 

Figure 28. Input menu 
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4.2  Input tool 

The "Input tool" window is for inputting text data from a file or the clipboard. Click 
"Input tool" in the Input menu to display the "Input tool" window. 

 

 

Figure 29. "Input tool" window elements 
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The operation procedure of the "Input tool" window is as follows: 

① Select "from File," "from Clipboard," or "Input string" as a source for inputting 
text data.  
 

② Specify where to reference a file. 

(Displayed when "from File" is selected in ①)  

 

③ Select a character encoding. 

(Displayed when "from File" is selected in ①) 

 

④ Specify whether to record the work folder change when recording a macro. 

(Displayed when "from File" is selected in ①) 

 

⑤ Select how to input the text data from the following.  

・Add as a new text 

・Add to the top 

・Add to the end 

・Add to the cursor position 

・Add next to the cursor position 

 

⑥ Enter a string. 

(Displayed when "Input string" is selected in ①)  

  

⑦ Click the button to input the text data and display it in the text area on the window 

based on the settings made in ① to ⑥.  
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“Do not record the work-folder change into macro.” is complemented below.  

File input/output functions such as ‘Input tool’ of WinActor Note and ‘Input image’ of 

WinActorEye have the setting “Do not record the work-folder change into macro.” 

This setting specifies whether a movement of work folder is recorded in the macro 

created with the macro recording.  

An example of ‘Input image’ of WinActorEye is described below.  

 

 

 [Checked] Do not record the work folder change into macro. 

The recorded macro does not have the row of changing the work folder. 

 

As the default work folder is the folder for saving scenarios, the image files input 

to WinActorEye are supposed to be stored in the folder.  

Storing scenarios file and their accompanying files in a folder, you can easily copy 

them by just copying the folder to another computer, and use them without 

correcting the file paths specified in the macros in them. 
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 [Not checked] Do record the work folder change into macro. 

The recorded macro has the row of changing the work folder. 

 

Image files are supposed to be gathered in the folder different from the folder for 

saving scenario files.  

Saving scenario files and accompanying files in separate folders, you can easily 

move the folder for scenarios.  

 

 

 

 

When the ‘Call scenario file’ node or a subscenario is executed in a scenario, the work 

folder is changed to the file path of the called or executed scenario file.  

To execute WinActor Note libraries properly after such call or execution in the 

scenario, place the ‘Note_SetWorkFolder’ library before the WinActor Note libraries 

and specify ‘Scenario_folder’ for the ‘Specify_the_folder’ property, or place the 

‘Note_ReadAndRunMacro’ library before the WinActor Note libraries and change the 

work folder back in the macro file specified in it.  
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4.3  Dump file 

The "Dump file" window is for loading texts from a file as a hexadecimal dump image. 
Click "Dump file" in the Input menu to display the "Dump file" window.  

 

 

Figure 30. "Dump file" window elements 

The operation procedure of the "Dump file" window is as follows: 

① Specify where to reference a file. 
 

② The size of the selected file will be displayed. 
 

③ Specify a start position in bytes to dump the file. (The initial value is empty.) 
 

④ Specify a size in bytes to dump the file.  
(The maximum size that can be dumped is 1048576 bytes.) 

 

⑤ If you check the box, the maximum value "1048576" will be automatically set in 

④, and you cannot change the dump size. If you uncheck the box, the value 

entered before checking the box will be restored, and you can change the value. 
 

⑥ Select whether to display addresses. 
 

⑦ Select whether to record the work folder change when recording a macro. 
 

⑧ Click the button to load the file and display it in the text area on the window as 

a hexadecimal dump image based on the settings made in ①  to ⑦. The 

example of the window with a hexadecimal dump displayed is shown below. 
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Figure 31. Example of "Dump file" (with addresses displayed) 

 

Figure 32. Example of "Dump file" (without addresses displayed) 
 

4.4  Clear 

Click "Clear" in the Input menu to discard the text data and return WinActor Note to 
its initial state. 

 

 

4.5  Load a file 

Click "Load a file" in the Input menu. The window to select a file will open. 
Click ‘Open’ to load a selected text file into the text area of WinActor Note. You can 

specify a character encoding.  
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Figure 33. Loading the text file 
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4.6  Paste 

Click "Paste" in the Input menu to paste text data from the clipboard into the text 
area of WinActor Note. 

 

 

 

 

Figure 34. Pasting the text data from the clipboard 
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5  Output 

5.1  Output menu 

The Output menu has functions for outputting text data created/edited on WinActor 
Note to a file or the clipboard.  

 

 

Figure 35. Output menu 
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5.2  Output tool 

The "Output tool" window is for outputting text data to a file or the clipboard. Click 
"Output tool" in the Output menu to display the "Output tool" window. 

 

 

Figure 36. "Output tool" window elements 

The operation procedure of the "Output tool" window is as follows: 

① Select a range of text data to be output. 
 

② Select "to File" or "to Clipboard" as an output destination.  
 

③ Specify a file path for the output destination. 

(Displayed when "to File" is selected in ②) 

 

④ Select a character encoding. 

(Displayed when "to File" is selected in ②) 

 

⑤ Select a line-break code. 

(Displayed when "to File" is selected in ②) 

 

⑥ Specify whether to record the work folder change when recording a macro. 

(Displayed when "to File" is selected in ②) 

 

⑦ Select whether to include a line break-code at the end. 
 

⑧ Click the button to output the text data based on the settings made in ① to ⑦. 
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5.3  Save a file 

Click "Save a file" in the Output menu. The window to select a file will open. 
Select a filename, character encoding, and line-break code, and click the ’Save’ 

button to save the text data to a file.  
 
 

 

Figure 37. Saving the file 
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5.4  Copy selected block 

Click "Copy selected block" to copy text data in a selected block to the clipboard. 
     

 
 

 

Figure 38. Copying the selected block 
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5.5  Copy all 

Click "Copy all" to copy all text data to the clipboard.  

 

 

 

 

Figure 39. Copying all texts 
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6  Block extraction 

6.1  Block extraction menu 

The text data of WinActor Note are managed in a unit called "block."  
Basically, one line of text is handled as one block. Multiple lines can be handled as 

one block by operations such as merging blocks. 
WinActor Note provides many text edit functions for a selected block.  
With the "Block extraction" menu, you can perform operations such as deleting, 

merging, splitting, and searching for blocks.  
Pre-processing such as deleting empty lines (empty blocks) may simplify the text 

editing procedure. Perform block processing to make text editing easier depending on 
the situation.  

 
 

 

Figure 40. Block extraction menu 
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6.2  Block extraction tool 

The "Block extraction tool" window is for deleting unnecessary blocks and extracting 
necessary blocks. Click "Block extraction tool" in the Block extraction menu to display 
the "Block extraction tool" window.  

 
 

 

Figure 41. "Block extraction tool" window 

 
The operation procedure of the "Block extraction tool" window is as follows: 

① Select a range of blocks to be extracted. 
In addition to selecting a single block, you can also select multiple blocks by 
selecting "Selected block and blocks below" for example. 

 

② Select an operation to be performed on the blocks in the range specified in ①.  

 

③ Click the button to execute the block extraction based on the settings made in 

① and ②. 
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6.3  Block merge tool 

The "Block merge tool" window is for merging multiple blocks into one block. Click 
"Block merge tool" in the Extract block menu to display the "Block merge tool" window.  

 
 

 

Figure 42. "Block merge tool" window 

 
The operation procedure of the "Block merge tool" window is as follows: 

① Specify a keyword that serves as a separator for merging blocks. 
 

② Select a condition for the keyword specified in ①. 

 

③ Click the button to merge blocks based on the settings made in ① and ②. 
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6.3.1  Operation example 

 
When the texts below are loaded, one line is in the unit of one block by default. 
 

 

Figure 43. Before merge operation (one line in one block) 

 
To manage these texts as one block every three lines, it is effective to merge blocks 

by separating blocks containing "---." 
 

 

Figure 44. Block merge tool operation example 

 

 

Figure 45. Merge operation result (three lines in one block)  
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6.4  Block split tool 

The "Block split tool" window is for splitting one block into multiple blocks. Click 
"Block split tool" in the Block extraction menu to display the "Block split tool" window.  

 

 

Figure 46. "Block split tool" window 

The operation procedure of the "Block split tool" window is as follows:  

① Select a range for splitting a block.  
In addition to selecting a single block, you can also select multiple blocks by 
selecting "Selected block and blocks below" for example.  

 

② Specify this when you want to split a block using a keyword. 
 

③ Select a condition for splitting a block.  
 

④ Click the button to execute the block split based on the settings made in ① to 

③. 
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6.4.1  Operation example 1 

To split the unit of three lines in one block as shown in the figure below into one line 
in one block, "Split with line breaks" is useful.  

 

Figure 47. Before split operation (three lines in one block) 

 

 

Figure 48. Block split tool operation example 

 

 

Figure 49. After split operation (one line in one block) 
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6.4.2  Operation example 2 

To remove commas from the comma-separated texts as shown in the figure below 
and make one line in one block, "Split with keywords and delete them" (the keyword 
is "," in this example) is useful.  

 

 

Figure 50. Before split operation (comma-separated) 

 

Figure 51. Block split tool operation example 

 

Figure 52. After split operation (one line in one block) 
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6.5  Block search tool 

The "Block search tool" window is for searching blocks by specifying search 
conditions.  

Click "Block search tool" in the Block extraction menu to display the "Block search 
tool" window. 

 

 

Figure 53. "Block search tool" window 

 
The operation procedure of the "Block search tool" window is as follows:  

① Specify a search keyword. 
 

② Select a block search condition. 
 

③ Select what to do when the search hits. 
 

④ Click the button to execute the block search based on the settings made in ① 

to ③. 
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6.5.1  Operation example 

To narrow down to only blocks containing specific characters, "Delete the 
unmatched blocks" is useful. 

The example in the figure below is to narrow down to blocks containing "Length."  
 

 

Figure 54. Before search operation 

 

 

Figure 55. Block search tool operation example 

 

 

Figure 56. After search operation 
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6.6  Block number designation tool 

The "Block number designation tool" window is for specifying a block by number 
and performing an operation on the specified block. Click "Block number designation 
tool" in the Block extraction menu to display the "Block number designation tool" 
window.  

 

 

Figure 57. "Block number designation tool" window 

 
The operation procedure of the "Block number designation tool" window is as 

follows:  

① Specify a number for the block on which an operation to be performed.  

When selecting "Select" in ②, specify with one block number.  

When selecting "Mark," "Unmark," or "Delete" in ②, specify with one block 

number or with multiple block numbers. 
If "2,3,5" are specified, block numbers 2, 3, and 5 will be the targets of the 
operation. 
If "2-5" is specified, block numbers from 2 to 5 will be the targets of the operation.  
If "2-5,8-10" are specified, block numbers from 2 to 5 and from 8 to 10 will be 
the targets of the operation.  
If "3-" is specified, the third and subsequent blocks will be the targets of the 
operation. 

 

② Select an operation to be performed on the block(s) specified in ①. 

 

③ Click the button to execute the operation based on the settings made in ① and 

②. 
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6.6.1  Operation example 

"Block number designation tool" is useful when marking blocks with predetermined 
numbers. With "Block number designation tool," you can specify multiple numbers at 
a time by entering numbers like "1,3-5,8."  

 

 

Figure 58. Before block number designation operation 

 

 

Figure 59. Block number designation tool operation example 

 

 

Figure 60. After block number designation operation 
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7  Sort 

7.1  Sort menu 

The Sort menu has functions for sorting the entire text data of WinActor Note.  
 

 

Figure 61. Sort menu 
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7.2  Ascending sort 

Click "Ascending order" to sort blocks in ascending order. 
 

 
Figure 62. Ascending sort operation example 

 
 

 

Figure 63. Ascending sort operation result 
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7.3  Descending sort 

Click "Descending order" to sort blocks in descending order. 
     

 

Figure 64. Descending sort operation example 

 
 

 

Figure 65. Descending sort operation result 
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8  Cursor movement 

8.1  Cursor movement menu 

The "Cursor movement" menu has functions for moving the "cursor" on the text area.  
 

 

Figure 66. Cursor movement menu 
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8.2  Cursor movement tool 

The "Cursor movement tool" window is for moving the cursor on the text area. Click 
"Cursor movement tool" in the Cursor movement menu to display the "Cursor 
movement tool" window. 

 

 
 

Figure 67. "Cursor movement tool" window 

 
The operation procedure of the "Cursor movement tool" window is as follows:  

① Specify a movement of the cursor. 
 

② Click the button to move the cursor to the position specified in ①. 

 

Table 5. Operations with "Cursor movement tool" 

Key Cursor movement Description 

Home Clear selection The cursor moves to TOP. 

End Select EOT The cursor moves to EOT. 

↑ Select the previous block The cursor moves up one block. 

↓ Select the next block The cursor moves down one block. 

P Select the previous marked 

block 

The cursor moves to a marked block upward from 

the current position. 

If there is no marked block upward, the cursor 

moves to TOP. 

N Select the next marked 

block 

The cursor moves to a marked block downward 

from the current position. 

If there is no marked block downward, the cursor 

moves to EOT. 
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8.3  Select the previous block 

Click "Select the previous block" in the Cursor movement menu to move the cursor 
to the previous block.  

 

8.4  Select the next block 

Click "Select the next block" in the Cursor movement menu to move the cursor to 
the next block.  

 

8.5  Block number designation tool 

Click "Block number designation tool" in the Cursor movement menu to display the 
"Block number designation tool" window.  

 
For details of the operation, see "Section 6.6." 
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9  Mark 

9.1  Mark menu 

In WinActor Note, you can "mark" each block. 
You can move the cursor to a marked block or perform edit operations for only 

marked blocks.  
 

 

Figure 68. Mark menu 
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9.2  Mark tool 

The "Mark tool" window is for marking each block, removing marks, or providing an 
instruction of operation for marked blocks. Click "Mark tool" in the Mark menu to 
display the "Mark tool" window. 

 

 

Figure 69. "Mark tool" window 

 
The operation procedure of the "Mark tool" window is as follows:  

① Specify an operation related to "mark." 
 

② Click the button to execute the operation specified in ①. 
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9.3  Mark 

Click "Mark" to mark the currently selected block. The marked block will be 
displayed in red color. 

  

 

Figure 70. Mark operation result  
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9.4  Unmark 

Click "Unmark" to unmark the currently selected block.  
 

 

Figure 71. Unmark operation result 
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9.5  Select the previous marked block 

Click "Select the previous marked block" in the Mark menu to move the cursor to a 
marked block upward from the current position. 

If there is no marked block upward, the cursor moves to TOP.  

 

9.6  Select the next marked block 

Click "Select the next marked block" in the Mark menu to move the cursor to a 
marked block downward from the current position.  

If there is no marked block downward, the cursor moves to EOT. 

 

9.7  Block number designation tool 

Click "Block number designation tool" in the Mark menu to display the "Block 
number designation tool" window. 

For details of the operation, see "Section 6.6." 

 

9.8  Block search tool 

Click "Block search tool" in the Mark menu to display the "Block search tool" window. 
For details of the operation, see "Section 6.5." 
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10  Edit 

10.1  Edit menu 

The Edit menu has functions for changing, formatting, or deleting texts in blocks.  
 

 

Figure 72. Edit menu 
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10.2  Edit tool 

The "Edit tool" window is for performing edit operations such as addition and 
deletion on texts in blocks. Click "Edit tool" in the Edit menu to display the "Edit tool" 
window.  

 
 

 

Figure 73. "Edit tool" window 

The operation procedure of the "Edit tool" window is as follows: 

① Select a range of blocks for editing. 
 

② Specify a keyword. 

Depending on the selection of ③, the input field switches to one of "Keyword," 

"Parentheses," or "Number of characters."  
 

③ Select an edit operation. 
 

④ Click the button to execute the edit operation based on the settings made in ① 

to ③. 
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Table 6. "Edit tool" functions list 

No Operation Description 

1 Delete to the left (keyword 

deleted) 

Deletes text data (including the keyword part) 
located to the left of the specified keyword. If the 
specified keyword appears more than once, the text 
data to the left of the first (leftmost) keyword will be 
deleted.  

2 Delete to the right (keyword 

deleted) 

Deletes text data (including the keyword part) 
located to the right of the specified keyword. If the 
specified keyword appears more than once, the text 
data to the right of the last (rightmost) keyword will 
be deleted.  

3 Delete to the left Deletes text data (not including the keyword part) 
located to the left of the specified keyword. If the 
specified keyword appears more than once, the text 
data to the left of the first (leftmost) keyword will be 
deleted. 

4 Delete to the right Deletes text data (not including the keyword part) 
located to the right of the specified keyword. If the 
specified keyword appears more than once, the text 
data to the right of the last (rightmost) keyword will 
be deleted. 

5 Leave the text of inside 

parentheses 

Leaves only a text inside parentheses (eg, "", (), 
<>, etc.) specified as a keyword and deletes the 
rest of the text including parentheses.  

6 Leave the parenthesized text Leaves a text enclosed in parentheses (eg "", (), 
<>, etc.) specified as a keyword and deletes the 
rest of the text. 

7 Delete the parenthesized text Deletes a text enclosed in parentheses (eg "", (), 
<>, etc.) specified as a keyword and leaves the rest 
of the text. 

8 Delete to the left of the 

parentheses 

Deletes all text data to the left of a text enclosed 
in parentheses (eg "", (), <>, etc.) specified as a 
keyword. 

9 Delete to the right of the 

parentheses 

Deletes all text data to the right of a text enclosed 
in parentheses (eg "", (), <>, etc.) specified as a 
keyword. 

10 Delete all to the left (keyword 

deleted) 

Deletes text data (including the keyword part) 
located to the left of the specified keyword. If the 
specified keyword appears more than once, the text 
data to the left of the last (rightmost) keyword will 
be deleted.  

11 Delete all to the right 

(keyword deleted) 

Deletes text data (including the keyword part) 
located to the right of the specified keyword. If the 
specified keyword appears more than once, the text 
data to the right of the first (leftmost) keyword will 
be deleted.  

12 Add to the beginning Adds a text specified as a keyword at the 
beginning of a text of each target block. 
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13 Add to the end Adds a text specified as a keyword at the end of 
a text of each target block.  

14 Parenthesize Encloses the entire text data of each target block 
using parentheses (eg "", (), <>, etc.) specified as a 
keyword. 

15 Delete characters from the 

beginning 

Deletes the specified number of characters from 
the beginning of a text. 

16 Delete characters from the 

end 

Deletes the specified number of characters from 
the end of a text. 

17 Leave characters at the 

beginning 

Leaves the specified number of characters at the 
beginning of a text and deletes the rest of the text. 

18 Leave characters at the end Leaves the specified number of characters at the 
end of a text and deletes the rest of the text. 
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10.3  White space removal tool 

The "White space removal tool" window is for removing unnecessary white 
spaces in a text. 

When transferring information to a business system, there are many cases where 
an error occurs if extra white spaces are included. By using "White space removal 
tool," you can remove unnecessary white spaces and avoid errors.  

Click "White space removal tool" in the Edit menu to display the "White space 
removal tool" window. 

 

 

Figure 74. "White space removal tool" window 

 
The operation procedure of the "White space removal tool" window is as follows: 
 

① Select a range of blocks for removing white spaces. 
 

② Select which white spaces you want to remove. 
 

③ Click the button to execute the operation based on the setting made in ① and 

②. 
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10.3.1  Operation example 

The following is an example of the operation to remove white spaces at the 
beginning of each line. 

 

 

Figure 75. Before white space removal operation 

 

Figure 76. White space removal operation example 

 

Figure 77. After white space removal operation 
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10.4  Replace 

The "Replace" window is for replacing a specific word with other characters.  
Click "Replace" in the Edit menu to display the "Replace" window.  
 

 

Figure 78. "Replace" window 

 

The operation procedure of the "Replace" window is as follows: 

① Select a range of blocks for replacing a text. 
 

② Specify a text to be replaced. 
 

③ If you use a regular expression in ②, select the check box. 

 

④ Specify a text to be used after replacement. 
 

⑤ Click the button to execute the replacement based on the settings made in ① 

to ④. 
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10.4.1  Operation example 

"Replace" is useful when inserting a name in a simple greeting letter and the like. 
* If there is much information to insert, "Insertion tool" is useful. 

 

 

Figure 79. Before replacement operation 

 
Figure 80. Replacement operation example 

 

Figure 81. After replacement operation 
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10.5  Insertion tool 

The "Insertion tool" window is for inserting information into a text template. 
Click "Insertion tool" in the Edit menu to display the "Insertion tool" window. 

 

 

Figure 82. "Insertion tool" window 

 
The operation procedure of the "Insertion tool" window is as follows: 

① Select a range of blocks for inserting information. 
 

② Select data to be inserted. 
 

③ Specify a file path.  

(Displayed when "Insert from the file" is selected in ②) 

 

④ Select a character encoding for the data to be inserted. 

(Displayed when "Insert from the file" is selected in ②) 

 

⑤ Specify whether to record the work folder change when recording a macro. 

(Displayed when "Insert from the file" is selected in ②) 

 

⑥ Click the button to execute the insertion based on the settings made in ① 

to ⑤. 
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10.5.1  Operation example 1 (Insert WinActor variables) 

"Insert WinActor variables" is a function to insert current values of variables in 
WinActor into a text in WinActor Note. Current values of variables in WinActor are 
valid only when a WinActor scenario is running. Therefore, this operation works 
only when "Insert WinActor variables" is instructed from a WinActor scenario. 
When you execute "Insert WinActor variables" in the "Insert tool" window, nothing 

is executed. However, when recording a macro, the "Insert WinActor variables" 
operation is recorded as a macro as shown below.  

If this macro is instructed to run from a WinActor scenario, "Insert WinActor 
variables" will be operated.  

 

 

Figure 83. Macro recording of "Insert WinActor variables"  

 

Figure 84. Macro recording result for "Insert WinActor variables" 
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 Before inserting variables 

 After inserting variables 

Figure 85. Inserting current values of WinActor variables into WinActor Note 
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10.5.2  Operation example 2 (Clipboard - linewise) 

"Insert from clipboard (linewise)" is a function to insert information in the clipboard 
into a text in WinActor Note.  
 

① Load a text template into WinActor Note. 

  Embed the texts {0}, {1}, {2}… in the positions where you want to insert 
information.  

② Copy the line-wise information to the clipboard.  

  The information in the first, second, and third line of the clipboard is 
corresponding to {0}, {1}, and {2} respectively. 

③ The information in the clipboard will be inserted into {0}, {1}, {2}…of the 

template by executing "Insert from clipboard (linewise)."  
 

 

Figure 86. Before insertion (text template) 

Clipboard (linewise) 

NTTAT 

2019/2/1 

10:00 

11:00 

Tokyo 

 

  

Figure 87. After insertion 
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10.5.3  Operation example 3 (Clipboard - JSON format) 

"Insert from clipboard (JSON format)" is a function to insert information in the 
clipboard into a text in WinActor Note. 

 

① Load a text template into WinActor Note. 

  Embed the texts {information name}… in the positions where you want to 
insert information.  

② Copy the JSON format information to the clipboard.  

  In JSON format, enumerate the information name and the data as below. 
"Name": "NTTAT" 

③ The information in the clipboard will be inserted into {information name} of the 

template by executing "Insert from clipboard (JSON format)."  
 

 

Figure 88. Before insertion (text template) 

Clipboard (JSON format) 

{ 

 "Name": "NTTAT", 

 "Date": "2019/2/1", 

 "Start time": "10:00", 

 "End time": "11:00", 

 "Location": "Tokyo" 

} 

  

Figure 89. After insertion 
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10.5.4  Operation example 4 (File - linewise) 

"Insert from the file (linewise)" is a function to insert information in a file into a text 
in WinActor Note. 

 

① Load a text template into WinActor Note. 

  Embed the texts {0}, {1}, {2}… in the positions where you want to insert 
information. 

② Save the line-wise information to a file.  

  The information in the first, second, and third line of a file is corresponding to 
{0}, {1}, and {2} respectively. 

③ The information in the file will be inserted into {0}, {1}, {2}…of the template by 

executing "Insert from the file (linewise)." 

 

 

Figure 90. Before insertion (text template) 

File (linewise) 

NTTAT 

2019/2/1 

10:00 

11:00 

Tokyo 

 

  

Figure 91. After insertion 
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10.5.5  Operation example 5 (File - JSON format) 

"Insert from the file (JSON format)" is a function to insert information in a file into a 
text in WinActor Note. 

 

① Load a text template into WinActor Note. 

  Embed the texts {information name}… in the positions where you want to 
insert information. 

② Save the information to be inserted to a file in JSON format.  

  In JSON format, enumerate the information name and the data as below. 
"Name": "NTTAT" 

③ The information in the file will be inserted into {information name} of the 

template by executing "Insert from the file (JSON format)."  
 

 

Figure 92. Before insertion (text template) 

File (JSON format) 

{ 

 "Name": "NTTAT", 

 "Date": "2019/2/1", 

 "Start time": "10:00", 

 "End time": "11:00", 

 "Location": "Tokyo" 

} 

  

 

Figure 93. After insertion 
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10.6  Undo 

Click "Undo" in the Edit menu to undo the last edit operation. 

 

10.7  Redo 

Click "Redo" in the Edit menu to redo the last undone edit operation. 
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11  Terminal 

11.1  Terminal menu 

The Terminal menu has the following three functions. 
 
1. Function for connecting to, executing a command on, and disconnecting from 

Command Prompt or Windows PowerShell (hereinafter abbreviated as 
PowerShell) of a Windows computer on which WinActor Note runs, as well as 
an SSH server or a Telnet server 

2. Function for sending and receiving a file using an SCP client 
3. Function for generating a password file, SSH key, and host list file required for 

connection 
 
Click "Terminal" in the menu of WinActor Note as shown in Figure 94 to see 

functions available in the menu as shown in Figure 95. 
 

 

Figure 94. Terminal menu 
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Figure 95. Terminal functions 

 

Subsequent sections 11.2 to 11.7 describe the details of each function. 
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11.2  Shell tool 

Click "Shell tool" in the Terminal menu to display the "Shell tool" window as shown 
in Figure 96. 

 
 

 

Figure 96. Shell tool 
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A series of operation to connect to, execute a command on, and disconnect from 

PowerShell or Command Prompt is as follows. (For ① -1 to ④  in the following 

descriptions, see Figure 96.) 
 
[PowerShell operation] 

1) Click the button ①-1 to start a PowerShell session. 

2) Enter a command you want to execute with PowerShell in ②.  

3) Click the button ③ to execute the command entered in ② with PowerShell. 

4) Click the button ④ to end the PowerShell session. 

 
[Command Prompt operation] 

1) Click the button ①-2 to start a Command Prompt session.  

2) Enter a command you want to execute with Command Prompt in ②. 

3) Click the button ③ to execute the command entered in ② with Command 

Prompt. 

4) Click the button ④ to end the Command Prompt session. 

 
[Notes] 
1) The operation of PowerShell has been confirmed on the following environments. 

The operation is not guaranteed for all versions of PowerShell. Versions 2.0 and 
4.0 cannot be operated. 

 
<Confirmed PowerShell versions> 
5.1.14498.1005, 5.1.17763.592, 5.1.18362.752 
 

2) PowerShell and Command Prompt cannot be operated at the same time. 

3) After clicking the button ①-1 or ①-2, be sure to click the button ④ to end the 

session and then close the Shell window. 
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11.3  SSH tool 

Click "SSH tool" in the Terminal menu to display the "SSH tool" window as shown 
in Figure 97. 

 

 

Figure 97. SSH tool 
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"SSH tool" has the following three functions. 
1. Function to connect to, execute a command on, and disconnect from an SSH 

server 
(Hereinafter abbreviated as SSH client function) 

2. Function to send a file using an SCP client 
3. Function to receive a file using an SCP client 
 
Each series of operation for the three functions is described in 11.3.2 to 11.3.4. 
The connection settings to be performed at the beginning of the operations in 11.3.2 

to 11.3.4 are described in 11.3.1. 
 
[Notes] 
1) The operation of the SSH client function using this tool has been confirmed in 

the following environments. The operation is not guaranteed for all 
environments. 
 
<Confirmed SSH tool operation environments> 
OS: CentOS Linux release 7.6.1810 / SSH server: OpenSSH 7.4p1  
OS: Ubuntu 18.04.5 LTS / SSH server: OpenSSH_7.6p1 
 

2) Connection via a proxy server is not available with this tool.  
3) The password authentication can lead to account cracks. It is recommended 

that you use the public key authentication whenever possible.  
4) It does not work with an authentication agent that allows the specification of 

SSH key and passphrase to be omitted.  
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11.3.1  Connection settings 

This subsection describes the connection settings to be performed at the beginning 
of the operations described in 11.3.2 to 11.3.4. 

As for a window for the connection settings, Figure 98 shows the connection 
settings part of the window shown in Figure 97. 

 

 

Figure 98. Connection settings (Left: Password authentication, Right: Public key 
authentication) 

 

For A-①, B-① to B-②-2, and ③ to ⑪ in the following procedure and note, see 

Figure 98. 
 
[Setting procedure] 
1) First, select "Password authentication" or "Public key authentication." Click the 

radio button to the left of "Password authentication" or "Public key 

authentication" (small circle button near A-① or B-①) in Figure 98. 

2) (For "Public key authentication" only) Drag and drop the private key file created 

in 11.6 to B-②-1, or click the button B-②-2 to select the private key file. 

3) For ③ to ⑪, set values according to Table 7. 
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Table 7. Connection settings (③ to ⑪ in Figure 98) 

No. in Figure 98 Settings Remarks 

③ Specify a character code format for 
sending to the server and for exporting 
to WinActor Note.  

 

④ Specify a line-break code format for 
sending to the server. 

 

⑤ Specify an IPv4 address of the SSH 
server to be connected.  

<Example of IPv4 
address> 
192.168.1.5 

⑥ Specify a port number of the SSH 
server to be connected. 

 

⑦ Specify a login name to be used when 
logging in to the server.  
 

 

⑧-1, ⑧-2 Drag and drop the password file created 

in 11.5 to ⑧-1, or click the button ⑧-2 

to select the password file.  
 
<For "Password authentication"> 
Use the password file that contains the 
password required to log in to the SSH 
server. 
 
<For "Public key authentication"> 
Use the password file that contains the 
passphrase set for the private key.  

 

⑨ Enter a string containing the end of the 
prompt that will be displayed when the 
login process is completed. 
This tool determines that the login is 
completed by receiving the string 
specified here at the end from the 
server.  
 
If the prompt is displayed as 
"[user@demoserver ~]$ ," you can use 

"$" as a value for ⑨. (*1) 

 
If you want to specify more than one, 
enter with comma-separated values. 
(Example) Enter "$,#" for specifying "$" 
and "#."  

*1 
"" in the sentence 
are not included as 
a string.  

⑩ Specify a maximum wait time in each 
step of the login process to the SSH 
server in seconds. Adjust with an 
appropriate value according to your 
environment. 

 

⑪-1, ⑪-2 Drag and drop the know hosts file 

created in 11.7 to ⑪-1, or click the 
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button ⑪-2 to select the know hosts 

file. 
By setting this item, you can limit the 
connection to only those connections 
that have been confirmed with "Know 
hosts file generation tool" in advance.  

 
 
[Note] 

1) For "Password authentication," use the same drive name in "Password file" (⑧

-1) and "Know hosts file" (⑪-1).  

For "Public key authentication," use the same drive name in "Password file" (⑧

-1), the private key file (B-②-1), and "Know hosts file" (⑪-1).  
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11.3.2  SSH client function 

This subsection describes the operation to connect to, execute a command on, and 
disconnect from an SSH server. 

When connecting to the SSH server, first configure the connection settings in 11.3.1 
in advance. 

Figure 99 shows the window related to the SSH client operation. 
 

 

Figure 99. SSH client operation 

 

The operation of SSH client is as follows. (For ① to ⑦ and ★ in the following 

descriptions, see Figure 99.) 

The check box of ★ allows you to select whether or not to record the work folder 
change when recording a macro.  

 
 
[SSH client operation] 

1) Select the tab ①. 

2) Click the button ② to open the SSH client. 

3) Enter a command you want to execute with the SSH client in ③-1.  

Or, check ③-2 to enable the control code and select the control code in ③-3.  

4) In ④, specify a string including the end of the message indicating that the 

command processing has been completed.  

5) In ⑤, specify a maximum wait time before the string of ④ is displayed.  

6) Click the button ⑥ to execute the command entered in ③-1 (③-3 when the 

control code is enabled with ③-2) on the SSH client. 

7) Click the button ⑦ to end the SSH client session. 

 
[Notes] 

1) After clicking the button ②, be sure to click the button ⑦ to end the session 

and then close the "SSH tool" window.  
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2) Only text can be entered in ③-1 (command field). If control characters are 

pasted into ③-1 (command field), the intended control characters may not be 

sent to the server. Use ③-2 and ③-3 to send control characters. 

3) When receiving a control code from the server, unintended characters such as 
□ may be displayed on the WinActor Note window. The character like □ 
representing the control code cannot be specified as a keyword for functions 
such as "Search tool for block" (see 6.5). 

 

11.3.3  Function to send a file using an SCP client  

This subsection describes the operation to send a file using an SCP client.  
When sending a file using the SCP client, first configure the connection settings in 

11.3.1 in advance. 
Figure 100 shows the window related to the operation to send a file using the SCP 

client. 
 

 

Figure 100. Operation to send a file using SCP 

 

The operation to send a file using SCP is as follows. (For ① to ⑤ and ★ in the 

following descriptions, see Figure 100.) 

The check box of ★ allows you to select whether or not to record the work folder 
change when recording a macro. 

 
 
 
[Operation to send a file using SCP] 

1) Select the tab ①. 

2) In ②, specify a maximum wait time in each step of the login process to the SSH 

server in seconds. Adjust with an appropriate value according to your 
environment.  
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3) Drag and drop a file to be sent into ③-1, or click the button ③-2 to select a file 

to be sent. 

4) In ④, enter a storage destination path of the file of ③-1 on the SSH server. In 

the confirmed SSH tool operation environments, it should be specified as 
/home/user/destination. 

5) Click the button ⑤ to send the file. 

 
[Notes] 

1) Only a single file can be specified for "Source file" (③-1). Multiple files or a folder 

cannot be specified.  

2) For "Password authentication," use the same drive name in "Source file" (③-1), 

"Password file" (⑧-1 in Figure 98), and "Known hosts file" (⑪-1 in Figure 98). 

For "Public key authentication," use the same drive name in "Source file" (③-1), 

"Password file" (⑧-1 in Figure 98), "Known hosts file" (⑪-1 in Figure 98), and 

the private key file (B-②-1 in Figure 98). 
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11.3.4  Function to receive a file using an SCP client 

This subsection describes the operation to receive a file using an SCP client.  
When receiving a file using the SCP client, first configure the connection settings in 

11.3.1 in advance. 
Figure 101 shows the window related to the operation to receive a file using the 

SCP client. 

 
 

Figure 101. Operation to receive a file using SCP 

 

The operation to receive a file using SCP is as follows. (For ① to ⑤ and ★ in the 

following descriptions, see Figure 101.) 

The check box of ★ allows you to select whether or not to record the work folder 
change when recording a macro. 

 
[Operation to receive a file using SCP] 

1) Select the tab ①. 

2) In ②, specify a maximum wait time in each step of the login process to the SSH 

server in seconds. Adjust with an appropriate value according to your 
environment. 

3) In ③, enter a file to be received from the SSH server. In the confirmed SSH tool 

operation environments, it should be specified as /home/user/source/data.txt. 

4) Drag and drop a folder for storing the file of ③ in ④-1, or click the button ④-

2 to select a folder. 

5) Click the button ⑤ to receive the file. 

 
 
 
[Notes] 

1) Only a file can be specified for "Source file" (③). In the confirmed SSH tool 

operation environments, wildcards (* and ?) can be used for a file. A folder 
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cannot be specified.  

2) For "Password authentication," use the same drive name in "Source file" (③), 

"Password file" (⑧-1 in Figure 98), and "Known hosts file" (⑪-1 in Figure 98). 

For "Public key authentication," use the same drive name in "Source file" (③), 

"Password file" (⑧-1 in Figure 98), "Known hosts file" (⑪-1 in Figure 98), and 

the private key file (B-②-1 in Figure 98).  
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11.4  Telnet tool 

Click "Telnet tool" in the Terminal menu to display the "Telnet tool" window as shown 
in Figure 102. 

 
 

 

Figure 102. Telnet tool 
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A series of operation to connect to, execute a command on, and disconnect from a 
Telnet server (hereinafter abbreviated as Telnet client function) is described in 11.4.1 
and 11.4.2. 

 
[Notes] 
1) The operation of the Telnet client function using this tool has been confirmed in 

the following environment. The operation is not guaranteed for all environments. 
 
<Confirmed Telnet tool operation environment> 
OS: CentOS Linux release 7.8.2003 / Telnet server: Telnet-server-0.17-65 
 

2) Connection via a proxy server is not available with this tool. 
3) Telnet communicates authentication information and command contents using 

plaintext data. Therefore, use it only on a trusted internal network and avoid 
using it via the internet. 

4) The line-break code for sending is fixed to CR+LF. 

 

11.4.1  Connection settings 

This subsection describes the connection settings to be performed before 
connecting to a Telnet server. 

As for a window for the connection settings, Figure 103 shows the part for the 
connection settings in the window shown in Figure 102.  

 

 

Figure 103. Connection settings 

 

For ① to ⑨ in the following procedure, see Figure 103. 

 
[Setting procedure] 

For ① to ⑨, set values according to Table 8.  
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Table 8. Connection settings (① to ⑨ in Figure 103) 

No. in Figure 103 Setting Remarks 

① Specify a character code format for 
sending to the server and for exporting 
to WinActor Note. 

 

② Specify an IPv4 address of the server 
to be connected. 

<Example of IPv4 
address> 
192.168.1.5 

③ Specify a port number of the Telnet 
server. 

 

④ Specify a login name to be used when 
logging in to the Telnet server. 

 

⑤-1, ⑤-2 Drag and drop the password file 

created in 11.5 to ⑤ -1, or click the 

button ⑤-2 to select the password file. 

 

⑥ Specify a string containing the end of 
the message that the Telnet server 
prompts for a username. 
In the confirmed Telnet tool operation 
environment, "login:" set as the default 
value can be used as the input value. 

 

⑦ Specify a string containing the end of 
the message that the Telnet server 
prompts for a password. 
In the confirmed Telnet tool operation 
environment, "Password:" set as the 
default value can be used as the input 
value. 

 

⑧ Specify a string containing the end of 
the prompt that will be displayed when 
the login process is completed.  
In the confirmed Telnet tool operation 
environment, "$" set as the default 
value can be used as the input value. 
If you want to specify more than one, 
enter with comma-separated values. 
(Example) Enter "$,#" for specifying "$" 
and "#."  

 

⑨ Specify a maximum wait time in each 
step of the login process to the Telnet 
server in seconds. Adjust with an 
appropriate value according to your 
environment. 
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11.4.2  Telnet client function 

This subsection describes the operation to connect to, execute a command on, or 
disconnect from a Telnet server. 

When connecting to the Telnet server, first configure the connection settings in 
11.4.1 in advance. 

Figure 104 shows the window related to the Telnet client operation. 
 

 

Figure 104. Telnet client operation 

 

The operation of Telnet client is as follows. (For ① to ⑦ and ★ in the following 

descriptions, see Figure 104.) 

The check box of ★ allows you to select whether or not to record the work folder 
change when recording a macro. 

 
[Telnet client operation] 

1) Select the tab ①. 

2) Click the button ② to open the Telnet client. 

3) Enter a command you want to execute with the Telnet client in ③-1. 

Or, check ③-2 to enable the control code and select the control code in ③-3. 

4) In ④, specify a string containing the end of the message indicating that the 

command processing has been completed.  

5) In ⑤, specify a maximum wait time before the string of ④ is displayed. 

6) Click the button ⑥ to execute the command entered in ③-1 (③-3 when the 

control code is enabled with ③-2) on the Telnet client. 

7) Click the button ⑦ to end the Telnet client session.  

 
[Notes] 

1) After clicking the button ②, be sure to click the button ⑦ to end the session 

and then close the "Telnet tool" window. 

2) Only a text can be entered in ③-1 (command field). If control characters are 

pasted into ③-1 (command field), the intended control characters may not be 

sent to the server. Use ③-2 and ③-3 to send control characters. 
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3) When receiving a control code from the server, unintended characters such as 
□ may be displayed on the WinActor Note window. The character like □ 
representing the control code cannot be specified as a keyword for functions 
such as "Block search tool" (see 6.5) and the like. 
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11.5  Password file generation tool 

Click "Password file generation tool" in the Terminal menu to display the "Password 

file generation tool" window as shown in Figure 105. After selecting ① and entering 

②, click the ‘Generate’ button ③. The window for saving the file appears.  

After specifying an output destination filename in ④, click the ‘Save’ button ⑤ to 

generate the password file.  
 

 

 

Figure 105. Password file generation tool 
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Details of each field of the "Password file generation tool" window (see ① and ② 

in Figure 105) are as follows. 

① You can select a method for encrypting a password. 
Currently, only "Standard" can be selected.  
 

② Enter a password to be encrypted. Only single-byte characters can be used. 
 

[Notes] 
1) The password file and its contents should be managed strictly so that it cannot 

be used by a third party.  
2) "Password file generation tool" is not the subject of macro functions (see 

Chapter 14). 
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11.6  SSH key generation tool 

Click "SSH key generation tool" in the Terminal menu to display the "SSH key 

generation tool" window as shown in Figure 106. After selecting ① and entering ②, 

click the ‘Generate’ button ③. The window for saving the key file appears.  

After specifying an output destination folder name in ④, click the ‘OK’ button ⑤ to 

generate the public/private key file. 
 
 

 

Figure 106. SSH key generation tool   
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Details of each field of the "SSH key generation tool" window (see ① and ② in 

Figure 106) are as follows. 

① You can select a key type for the SSH key (public or private) to be generated. 
 

② You can set a passphrase for the private key. If not entered, it will be a private 
key without passphrase. Only single-byte characters can be used for a 
passphrase. 
 

The filename to be generated follows the following rules. The examples below are 
when RSA-2048bit is specified for the type of key. 
 

・ Public key file 

"_pub" is added with "bit" removed for the name of the key type selected in ①. 

Example: RSA-2048_pub 
 

・ Private key file (without passphrase) 

"bit" is removed from the name of the key type selected in (①). 

Example: RSA-2048 
 

・ Private key file (with passphrase) 

"_pw" is added with "bit" removed for the name of the key type selected in ①. 

Example: RSA-2048_pw 
 

 
[Notes] 
1) The private key file and its contents should be managed strictly so that it cannot 

be used by a third party. 
2) For details on how to set a public key to an SSH server, refer to the manual of 

the SSH server to be used. 
3) "SSH key generation tool" is not the subject of macro functions (see Chapter 

14). 
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11.7  Known hosts file generation tool 

Click "Known hosts file generation tool" in the Terminal menu to display the "Known 

hosts file generation tool" window as shown in Figure 107. After entering ①, ②, and 

③, click the ‘Generate’ button ④. The window for saving the file appears. 

After specifying an output destination filename in ⑤, click the ‘Save’ button ⑥ to 

generate the known hosts file. 

 

 

Figure 107. Known hosts file generation tool 
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Details of each field of the "Known hosts file generation tool" window (see ① to 

③ of Figure 107) are as follows. 

① You can specify a name of a host that is allowed to connect. 
 

② You can specify a port number of a host that is allowed to connect.  
 

③ You can set a timeout value (in seconds) for the connection.  
 

 
If you want to set multiple hosts in a known hosts file, specify the generated known 

hosts file as the output destination. The confirmation dialog to add the host (Figure 
108) appears. By selecting ‘Yes’ in the dialog, you can set multiple hosts in one 
known hosts file. 

The image of the confirmation dialog (Figure 108) and the operation when each 
button on the dialog is selected are shown below. 
 

 

Figure 108. Confirmation dialog to add the host 

When ‘Yes’ is selected, 
 Adds the host to the specified known hosts file.  
When ‘No’ is selected, 
 Returns to the window for saving the file to reselect the known hosts file.  
When ‘Cancel’ is selected, 

Cancels the processing and returns to the "Known hosts file generation 
tool" window. 

 
[Note] 
1) "Known hosts file generation tool" is not the subject of macro functions (see 

Chapter 14). 
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12  Filer 

12.1  Filer menu 

The Filer menu has the following functions for: 

1. Reading and displaying contents of a folder on a Windows computer where 

WinActor Note is running,  

2. Copying/moving/deleting a file, creating a folder, 

3. Executing a file association, printing, and 

4. Copying to the clipboard. 

 

Click "Filer" in the menu of WinActor Note to see functions available in the menu 
as shown in Figure 109. Filer menu 

 

Figure 109. Filer menu 
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12.2  Select folder 

"Select folder" is a function to display a list of folder contents in the text area. 

 

Figure 110. "Select folder" window 

 

The operation procedure of the "Select folder" window is as follows: 

① Select a folder for which you want to display a list of its contents.  
(If no folder is specified, it will be the current user's home directory.) 
 

② Select which contents you want to display. "Show all" displays all files and 
folders in the selected folder.  

 

③ Select whether to enable file filtering. (*1) 
 

④ When you select the check box to enable file filtering in ③, specify a file filter. 

(*1) 
(If not entered, the file filtering will be disabled.) 
 

⑤ Select whether to show hidden files. 
 

⑥ Select whether to record the work folder change when recording a macro. 
 

⑦ Click the button to display the list of folder contents based on the settings made 

in ① to ⑥. 

A display example is shown in Figure 111. 
 

*1 The file filtering is a function to display only files and folders that match the 

regular expression. 
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Table 9. File filtering rules 

No. Rule Description 

1 . Matches one character. 

2 ? Matches zero or one character. 

3 * Matches zero or more characters. 

  

Figure 111. Folder contents listed in the text area 
 

Table 10. Descriptions of listed folder contents 

No. in Fig.111 Description 

①  The first line shows the path of the folder for 

which the contents are listed.  

②  Example of showing folders.  

③  Example of showing files. 

 

12.3  Update 

Click "Update" in the Filer menu to reload a list of folder contents specified in "Select 

folder" in Section 12.2 and update the contents listed in the text area. 

 

12.4  Move to folder 

If the line selected in the folder contents listed in the text area (Figure 111. Folder 

contents listed in the text area) is a folder, click "Move to folder" in the Filer menu to 

switch the display to a list of contents of that folder. It does not work when a file is 

selected. 

 

12.5  Copy file 

"Copy file" is a function to copy a specified file. If a folder is selected, the files and 

folders under that folder will also be copied.  
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Figure 112. "Copy file" window 

 
The operation procedure of the "Copy file" window is as follows: 

① Specify a source filename. (*1) 

(If a file or folder is selected in the folder contents listed in the text area shown 

in Figure 111. Folder contents listed in the text area, the selected file or folder 

will be set.) 

 

② Specify a destination filename or folder name. (*1) 

 

③ Select a copy type.(*2) 

 

④ Click the button to make the copy based on the settings made in ① to ③. 

 

*1 Specify it with an absolute path or a relative path from the work folder.  

*2 The description of each copy type is as follows. 
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Table 11. Descriptions of copy types 

No. Type Description 

1 Copy normally Makes a normal copy. If a file with the same 

filename exists in the destination, an error will 

occur. 

2 Copy forcibly Forcibly makes a copy even if a file with the same 

filename exists in the destination. 

3 Copy if the date is 

newer  

Makes a copy if the date and time of the source file 

is newer in the case where a file with the same 

filename exists in the destination.  
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12.6  Create folder 

"Create folder" is a function to create a folder. When creating a folder, be sure to 

select a folder as described in Section 12.2 before creating a folder. 

 

Figure 113. "Create folder" window 

The operation procedure of the "Create folder" window is as follows: 

① It shows a current folder. 

(A folder will not be created if you do not perform "Select folder" described in 

Section 12.2.) 

 

② Specify a folder name.  

 

③ Click the button to create the folder based on the settings made in ① and  

② (*1) 

*1  If there is a folder with the same name, an error will occur.  

 

12.7  Move files 

"Move files" is a function to move specified files. If a folder is selected, the files and 

folders under that folder will also be moved. 

 

Figure 114. "Move files" window 
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The operation procedure of the "Move files" window is as follows: 

① Select "Move marked files” or "Move the selected file" 

 

② Specify a source filename. (*1) 

・If a file or folder is selected in the folder contents listed in the text area (Figure 

111. Folder contents listed in the text area), the selected file or folder will be set. 

・This cannot be specified if "Move marked files" is selected in ①.  

 

③ Specify a destination filename. (*1) 

 

④ Specify a type of move. (*2) 

 

⑤ Click the button to move the file(s) based on the settings made in ① to ④.  

*1 Specify it with an absolute path or a relative path from the work folder. 

*2 The description of each type of move is as follows. 

Table 12. Descriptions of types of moves 

No. Type Description 

1 Move normally Moves files normally. If a file with the same 

filename exists in the destination, an error will 

occur. 

2 Move forcibly Forcibly moves files even if a file with the same 

filename exists in the destination. If a folder is 

specified, an error will occur.  

3 Move if the date is 

newer  

In the case where a file with the same filename 

exists in the destination, forcibly moves a file if the 

date and time of the source file is newer. If a folder 

is specified, an error will occur. 

 

12.7.1  Operation when "Move marked files" is selected 

When "Move marked files" is selected, the marked files with "9.3 Mark" in the folder 

contents listed in the text area (Figure 111. Folder contents listed in the text area) 

will be moved. 

An example of moving the marked files is shown below. 
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Figure 115. Example of moving the marked files 

 ・The marked files ① and ② will be move to the destination. 

 

12.8  Execute 

Click "Execute" in the Filer menu to execute a file selected in the folder contents 

listed in the text area (Figure 111. Folder contents listed in the text area) 

according to the extension association.  

 

12.9  Execution tool 

"Execution tool" is a function to execute a selected file according to the 

extension association. You can specify arguments. 

 

Figure 116. "Execution tool" window 
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The operation procedure of the "Execution tool" window is as follows: 

① Specify a file you want to execute according to the extension association 

with an absolute path or a relative path from the work folder. 

 

② Specify arguments. 

(It may not be enabled depending on the extension association setting.) 

 

③ Click the button to execute the file according to the extension association 

based on the settings made in ① and ②. 

 

12.10  Print 

Click "Print" in the Filer menu to print a file selected in the folder contents listed 

in the text area (Figure 111. Folder contents listed in the text area) according to 

the print settings on a Windows computer. 

 

12.11  Copy 

This is to copy a filename or file itself for a file selected in the folder contents 

listed in the text area (Figure 111. Folder contents listed in the text area) to the 

clipboard.  

 

Figure 117. "Copy" window 

The operation procedure of the "Copy" window is as follows: 

① Select what you want to copy to the clipboard. 

 

② Click the button to copy based on the setting in ①. 

Table 13. Description of the "Copy" window 

No. What to copy Description 

1 Copy the filename to the 

clipboard 

Copies a filename of the selected file 

(absolute path) to the clipboard.  

2 Copy the file to the clipboard Copies the selected file itself to the 

clipboard. After executing the operation, you 
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can paste the file by pressing the Ctrl+V key. 

 

12.12  Delete file 

Click "Delete file" in the Filer menu to delete a file selected in the folder contents 

listed in the text area (Figure 111. Folder contents listed in the text area). If a 

folder is selected, the files and folders under that folder will also be deleted. 

To delete a file, click "Delete file" to display the following dialog and click ‘Yes.’ 

 

Figure 118. "Delete file" confirmation dialog 
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13  Tab 

13.1  Tab menu 

By using the "Tab" menu, you can perform edit operations with multiple text areas 
open. You can manage text areas with tab names.  

 

13.2  Tab tool 

The "Tab tool" window is for adding or deleting a tab, or selecting a tab (bringing a 
tab to the front). Click "Tab tool" in the menu to display the "Tab tool" window.  

 

 

Figure 119. "Tab tool" window 

 

 

The operation procedure of the "Tab tool" window is as follows:  

① Enter a name of a tab to be operated. 

 

② Select an operation to be performed for the tab. 

 

③ Click the button to execute the tab operation based on the settings made in ① 

and ②. 
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Table 14. Tab tool functions 

No. Function Description 

1 Add Creates a new tab by specifying a tab name. 
The newly created tab will be selected. 
An error will occur if a tab with the same name exists. 

2 Select 

(raise error if not selectable) 

This is to select a tab specified by the tab name so 
that you can edit texts in the text area of that tab. 
An error will occur if the specified tab does not exist. 

3 Select 

(add if not selectable) 

This is to select a tab specified by the tab name so 
that you can edit texts in the text area of that tab. 
If the specified tab does not exist, a new tab will be 
added and selected.  

4 Delete Deletes a tab specified by the tab name. An error will 
occur if the specified tab does not exist. 
The "Main" tab cannot be deleted. 

5 Delete tabs other than the 

main tab 

Deletes all tabs except the "Main" tab. 
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13.2.1  Operation example (adding a tab) 

This is an example of adding a tab named "New tab." 
 

 

Figure 120. Operation of adding a tab 

 

  

Figure 121. Before adding a tab 

 

  

Figure 122. After adding "New tab" 

 
You can edit texts in each text area of the two tabs of "Main" and "New tab" 

independently.  
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14  Macro 

14.1  Macro functions  

You can save an edit procedure on WinActor Note to a file by using the Macro 

functions. A macro of WinActor Note can be run from a scenario of WinActor. 

 

14.2  Edit macro 

You can edit a macro of WinActor Note in the "Edit macro" pane. If the pane is not 

displayed, click "Edit macro" in the "View" menu to display the "Edit macro" pane. 

The elements of the "Edit macro" pane are as shown below. 

On the menu bar, there are menus for executing each function. 

The macro area displays a macro being edited. 

When an edit operation is performed in the text area of WinActor Note with the macro 

recording function turned "ON," the performed edit operation will be recorded in the 

macro area. 

Use the "Edit" menu to rearrange the order of operations in, change parameters of, 

or delete unnecessary parts in a recorded macro. 

Use the "Run" menu to check the operations of a created macro. 

Use the "Create" menu to save or load a created macro. 

 

Figure 123. "Edit macro" pane  
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14.3  Macro area 

The macro area displays "Command," "Parameters," "Error/Warning," and "User 

memo" for a macro. "Command" and "Parameters" are set automatically during the 

macro recording. "Error/Warning" displays warnings during the macro recording or 

errors when running the macro. You can write notes in "User memo." 

 

In the macro area, you can perform the keyboard and mouse operations shown in 

the table below.  

 

Table 15. Operations in the macro area 

Key Mouse Description 

↑ － Selects a previous operation. 

↓ － Selects a next operation. 

PageUp － Scrolls the macro area upward. 

PageDown － Scrolls the macro area downward. 

－ Click Selects a clicked operation. 

Enter Double-click Opens the "Edit macro item" window to edit parameters of 

an operation. 

See 14.8 for details. 

Delete － Deletes a selected operation. 

Insert － Inserts a blank row. 

Shift + 

Insert 

－ Inserts a loop operation (do/while). 

- * － Moves the order of a selected operation upward.  

+ * － Moves the order of a selected operation downward.  

. * － Removes the error/warning for a selected operation. 

F2 Double-click On the user memo field, double-clicking or pressing the F2 

key changes the user memo field to the edit mode. 

F5 － Runs all macro operations. 

F6 － Runs a macro step by step. 

F9 － Turns the recording function ON/OFF. 

Ctrl+Z － Undoes the last edit operation. 

Ctrl+Y － Redoes the last undone edit operation. 

Ctrl+N - Clears the macro area and restores it to the initial state. 
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Ctrl+O - Displays the file selection dialog for loading a macro saved 

in a file. 

Ctrl+S - Displays the file selection dialog for outputting a macro file 

being edited. 

* Can be operated only with the numeric keypad. 
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14.4  Create 

The "Create" menu is to save or load a created macro. 

 

Figure 124. "Create" menu 
 

Table 16. Description of the "Create" menu 

No. Function Description 

1 New Clears the macro area and restores it to the initial state. 

2 Open Loads a macro stored in a file. 

The file selection window appears when clicked. In the file 

selection window, select a file to be loaded. 

3 Save Saves a macro in the macro area to a file. 

The file selection window appears when clicked. In the file 

selection window, select a file to save a macro. 
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14.5  Edit 

Use the "Edit" menu to rearrange the order of operations in, change parameters of, 

or delete unnecessary parts in a recorded macro. 

 

 

Figure 125. "Edit" menu 
 

Table 17. Description of the "Edit" menu 

No. Function Description 

1 Insert Inserts a blank row. 

2 Add loop Inserts do/while before and after a selected operation 

to enable loop execution. 

3 Delete Deletes a selected operation. 

4 Edit Opens the "Edit macro item" window to edit 

parameters of a selected operation. 

See 14.8 for details. 

5 Remove error/warning Removes the error/warning for a selected operation. 

6 Up Moves the order of a selected operation upward. 

7 Down Moves the order of a selected operation downward. 

8 Undo Undoes the last edit operation. 

9 Redo Redoes the last undone edit operation. 
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14.6  Run 

Use the "Run" menu to check the operations of a created macro. 

 

 

Figure 126. "Run" menu 
 

Table 18. Description of the "Run" menu 

No. Function Description 

1 Run all Runs all macro operations from No.1 to the end. 

If an error occurs, it will stop at that row.  

2 Run selected Runs a selected step in a macro. 

3 Step Runs a macro step by step. 

4 Stop macro Stops a running macro. 
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14.7  Record 

The macro recording function can be switched "ON" and "OFF" using the "Record" 

menu.  

 

 

Figure 127. "Record" menu 

 

Table 19. Recording state and its display 

Recording state Display 

ON  

OFF  
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14.8  Edit macro item 

In the "Edit macro item" window, you can edit "Command name," "Parameter," 

"Error/Warning," and "User memo" for a selected operation in a macro. 

 

 

Figure 128. "Edit macro item" window 

 

Table 20. Description of the "Edit macro item" window 

No. Item Description 

1 Command name Enter a command name. 

2 Error/Warning Shows an error/warning. 

3 Remove error/warning  Removes an error/warning. 

4 User memo You can enter notes. 

5 Add above Adds a parameter above a selected parameter. 

6 Add below Adds a parameter below a selected parameter. 

7 Delete Deletes a selected parameter. 

8 Parameters Shows parameters being edited. 

9 OK Confirms your edit.  

10 Cancel Cancels your edit.  
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14.9  Running a macro from a scenario of WinActor 

If you want to run a macro of WinActor Note from a scenario of WinActor, use 

"Note_ReadAndRunMacro" provided as a library on WinActor. Place the 

"Note_ReadAndRunMacro" library in the flowchart area of WinActor and specify a file 

path of a saved macro in the property window of the library. 

 

 

Figure 129. "Note_ReadAndRunMacro" library 

 

 

Figure 130. "Note_ReadAndRunMacro" library property window 
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15 Notes 

15.1  Operation while a scenario is running on WinActor 

The edit operations on WinActor Note are disabled while a scenario is running on 
WinActor. 
 WinActor Note has the Edit mode (a mode for directly editing the window). If a request 
to run a scenario is received from WinActor during this Edit mode, the edit operations 
on the WinActor Note and the scenario execution on WinActor may conflict. Therefore, 
the edit operations on WinActor Note will be disabled while a scenario is running on 
WinActor. A macro that has already been run will stop if a request to run a scenario is 
received. 
 

15.2  Known hosts file 

The known hosts file used in WinActor Note v6 needs to be updated. 
 Since the SSH key generation algorithm has been changed from ecdsa-sha2-
nistp256 to ssh-ed25519, it is necessary to update the known hosts file generated 
using this algorithm. 
 

15.3  File encoding 

Depending on a file encoding, behaviors of a scenario may change between 
WinActor Note earlier than Ver.7.2 and WinActor Note Ver.7.2 or later. 

Table 21. Precautions for specifying the file encoding 

Encoding in WinActor Note 

earlier than Ver.7.2 

Encoding in WinActor Note 

Ver.7.2 or later 

UTF-16 Loading may fail due to a change in the order of 

bytes (endianness) (Earlier than Ver.7.2: Big 

Endian, Ver.7.2 or later: Little Endian)  

UTF8, UTF-16, UTF-16BE, UTF-16LE, 

UTF_32, UTF_32BE, UTF_32LE 

Loading may fail due to a change in the presence 

or absence of BOM (Earlier than Ver.7.2: without 

BOM, Ver.7.2 or later: with BOM) 

EUC_TW Loaded as UTF-8 

 

15.4 Behaviors on calling scenario file 

When WinActor starts executing a scenario, the ‘Call scenario file’ node, or the 
‘GoToScenario’ library, input data of WinActor Note will not be initialized. 
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